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Introduction 

HOUSATONIC PROJECT VIEWER SOLO PC 2007 SP2 is the stand-alone PC viewer of Microsoft Project 
files. It offers most view capabilities regarding Gantt Chart, Tracking Gantt, Network Diagram, Resource 
Sheet, Resource Graph, Task Usage, Resource Usage and Reports. 
 
HPV Solo 2007 SP2 is designed as a scalable and robust solution for viewing Microsoft Project files in a 
corporate environment. The following versions of Microsoft Project files are supported in this release: 
 
1. Microsoft Project 98 
 
2. Microsoft Project 2000 
 
3. Microsoft Project 2002 
 
4. Microsoft Project 2003 
 
5. Microsoft Project 2007 
 
This document helps you view your Microsoft Project files on your computer. 
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End-User License Agreement 

1. License.  A.  Subject to all of the terms and conditions hereof, Viewer Central, Inc,. a Delaware 
corporation (the "Licensor") hereby GRANTS to the end-user (the "Licensee") a non-transferable License 
to use the software program entitled Housatonic Project Viewer SOLO/PC 2007 SP2 (the "Viewer"), in 
object code, for five years (the "Term"), terminable as specified herein, which Licensee hereby accepts 
(the "License").  Licensor may assign its rights under this Agreement, and delegate its duties hereunder, 
to any of its affiliates.  Licensee acknowledges that it has no right to modify the Viewer without Licensor's 
prior written consent. 
 
2. Location and Use of Software.  The Viewer shall be used by Licensee only on one computer (per seat 
license).  The Viewer shall be used only for the conduct and operation of Licensee's own business, for the 
benefit of Licensee and its customers.  Licensee shall under no circumstances assign or attempt to 
sublicense the License to any other person, and any attempt to do so would constitute a material breach 
of this Agreement.   
 
3. Copies.  No copying of the Viewer is permitted except for one back-up copy. 
 
4. Consideration.  The royalties for this License are set forth in the check-out cart on the site. 
 
5. Non-Disclosure, Confidentiality.  A.  The Viewer, and any future permitted modifications, changes, 
enhancements, upgrades, revisions, or additions made to the Viewer, whether made or installed Licensor, 
Licensee, or a third party, are and shall be the sole and exclusive property of Licensor, including all 
applicable Intellectual Property rights inherent therein and appurtenant thereto.  Licensee shall not sell, 
transfer, publish, disclose, display or otherwise make available to others any source code or object code, 
documentation, or other material relating to the Viewer.  Licensee shall assist Licensor in identifying and 
preventing any use or disclosure of the source code or object code of the Viewer, or of any portion 
thereof, or any of the algorithms or logic contained therein.  Without limitation of the foregoing, Licensee 
shall notify Licensor immediately if Licensee learns or has reason to believe that any person has violated, 
or intends to violate, the terms of this Agreement, or, if not bound thereby, intends to infringe upon or 
dilute Licensor's Intellectual Property in any way whatsoever; and Licensee will cooperate with Licensor in 
seeking injunctive or other equitable relief in the name of Licensee or of Licensor against any such person. 
 
B. Licensee hereby acknowledges that the Viewer contains proprietary Intellectual Property of Licensor, 
and agrees to maintain the confidentiality of the Viewer in a manner using at least as great a degree of 
care as the manner used to maintain the confidentiality of Licensee's own most secret and valuable 
information.  Licensee hereby acknowledges that the disclosure by Licensee or any of its employees or 
agents of any aspect or portion of the Viewer, or any of the confidential information referred to herein or 
any other information which ought to remain confidential, would give rise to irreparable injury to Licensor, 
which is inadequately compensable in damages.  Accordingly, in order to prevent any disclosure or dilution 
of Licensor's Intellectual Property, Licensor may seek or obtain emergency injunctive relief. 
 
C. All of the undertakings and obligations relating to confidentiality and non-disclosure, whether contained 
in this paragraph or elsewhere in this Agreement, and whether of Licensor or of Licensee, shall survive the 
termination of this Agreement for any reason whatsoever. 
 
6. Warranty.  Licensor warrants that the Viewer is operational and substantially free of material defects. 
 Licensor disclaims any other warranties, including any warranties that might otherwise be implied at law, 
such as the implied warranties of merchantability or of fitness for a particular purpose. 
THE WARRANTY STATED ABOVE IS A LIMITED WARRANTY, AND IS THE ONLY WARRANTY MADE BY 
LICENSOR TO LICENSEE.  LICENSOR DISCLAIMS, AND LICENSEE HEREBY EXPRESSLY WAIVES, ANY 
OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED.  LICENSOR SHALL HAVE NO LIABILITY WITH 
RESPECT TO ITS OBLIGATIONS UNDER THIS AGREEMENT, OR OTHERWISE, FOR ANY EXEMPLARY, 
CONSEQUENTIAL, SPECIAL, INCIDENTAL, OR PUNITIVE DAMAGES, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.  THE ABOVE-STATED EXPRESS WARRANTY IS IN LIEU OF ALL OTHER 
LIABILITIES OR OBLIGATIONS OF LICENSOR FOR DAMAGES THAT MIGHT ARISE OUT OF, OR IN 
CONNECTION WITH, THE DEVELOPMENT, USE, OR PERFORMANCE OF THE VIEWER. 
 
7. Termination.  This Agreement shall terminate at the end of the Term, unless the Parties agree to extend 
this Agreement, or either party has previously terminated the Agreement for breach.  Any termination of 
this Agreement shall automatically, and without any further action by Licensor, terminate and extinguish 
the License, whereupon, Licensor shall have the right to take immediate possession of the Viewer, and all 
copies thereof, wheresoever located, and all documentation thereto, without notice or demand. 
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 Notwithstanding the foregoing, all provisions hereof relating to confidentiality of the Viewer and dispute 
resolution shall survive the termination of this Agreement. 
 
8. Taxes.  Licensee shall pay all taxes, whether national or local, howsoever designated, which are levied 
or imposed by reason of the transaction and future transactions contemplated hereby. 
 
9. Binding Effect.  This Agreement shall inure to the benefit of, and shall be binding upon, each of the 
parties hereto, their respective heirs, personal representatives, administrators, successors and assigns. 
 
10. Choice of Law.  The validity, interpretation, and enforcement of this Agreement, and all other 
instruments and documents executed in connection with this transaction, shall be governed by the laws of 
the Commonwealth of Massachusetts, excluding those laws relating to the resolution of conflicts between 
laws of different jurisdictions.  Licensee hereby waives, in the case of any such action or proceeding 
brought in state or federal courts in the Commonwealth of Massachusetts, defenses based on venue, 
jurisdiction, or forum non conveniens.  All parties waive any right to raise, as a defense or otherwise, 
conflict of laws issues to challenge the governing law identified in this Agreement. 
 
11. Interpretation and Rules of Construction; Definitions.  The section and subsection headings and 
captions contained in this Agreement are for reference purposes only, and shall not affect in any way the 
meaning or interpretation of this Agreement.  Whenever the context shall require, all words herein in the 
masculine gender shall be deemed to include the feminine or neuter genders, all singular words shall 
include the plural, and plural words shall include the singular.  The use of the word "person" shall refer to 
all legal persons, whether natural or created by statute or other legal process including, but not limited to, 
any individual, corporation, partner¬ship, association, joint-stock company, trust, limitada, limited liability 
company or partnership, unincorporated organization, or joint venture.  The term "source code" means 
such written rendition of software programs readable and comprehensible by humans, and the term 
"object code" means such rendition and compilation of software programs primarily readable by machines. 
 The term "Intellectual Property" shall include material protected by copyright, trademark, servicemark, 
trade secrets and know-how, and design and patent rights.  Any term herein that appears to be used as a 
defined term, but whose definition is missing from this Agreement, shall be defined in accordance with the 
definitions in any of the related documents or schedules attached hereto. 
 
12. Severability.  If any provision of this Agreement should be determined by a court of competent 
jurisdiction to be invalid, illegal or unenforceable, then that determination will not affect or impair the 
validity, legality, or enforceability of the remaining provisions contained herein. 
 
13. Attorneys' Fees.  If any legal proceeding is brought by a party to this Agreement to enforce its 
provisions, or to seek remedy for any breach hereof, then the prevailing party shall be entitled to receive 
its reasonable attorneys' fees and costs incurred in connection with that legal proceeding (including any 
appellate proceedings) from the other party. 



 

What is new in this version 

Custom groups 
HPV Solo 2007 SP2 now supports viewing most of the custom groups defined in project files.  
 
Complete timescale 
With this enhancement you can see all the timescale tiers as defined and saved in project files. 
 
Information 
HPV Solo 2007 SP2 allows to view the information dialogs on all Tasks, Resources and Assignments. 
 
Advanced text styles 
With HPV Solo 2007 SP2 new text styles are displayed as they were defined. 
 
Silent Print 
The new silent print option allows now to print any project files without any human intervention (HPV Solo 
2007 SP2.exe /dp "%1"). 
 
Toolbar customizing 
HPV Solo 2007 SP2 preserves all modification of toolbars layout. 
 
Go To 
Go To menu option is now available. 
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Minimum System Requirements 

The minimum requirements your computer needs to run HPV Solo 2007 SP2 are listed below:  
 
Minimum System Requirements 
 
Computer/Processor Computer with Pentium 133 megahertz (MHz) or higher processor; Pentium III 

recommended 
Memory 64 MB of RAM 
Hard Disk 10 MB 
Operating System Windows 98, Windows 98 Second Edition, Windows Millennium Edition (Windows 

Me), Windows NT 4.0 with Service Pack 6 (SP6) or later, Windows 2000, or 
Windows XP or later  

Applications .NET Framework 2.0 
Display Super VGA (800 x 600) or higher-resolution monitor with 256 colors 
Peripherals Microsoft Mouse, Microsoft IntelliMouse®, or compatible pointing device 
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Installation Guide 

In order to install HPV Solo 2007 SP2 you need to perform the following steps:  
 
0. Log on to your computer. Make sure your user has administrative rights; 
1. In your Windows Explorer locate the kit archive; 
2. Unzip the kit archive; 
3. Run Setup.exe and follow the instructions that appear on the screen; 
4. Click Start/Programs/Viewer Central Inc/HPV Solo 2007 SP2/HPV Solo 2007 SP2 to run the 
application. 
 
 
In order to install HPV Solo 2007 SP2 silently you need to perform the following steps: 
 
1. Open Command Prompt window; 
2. Locate the folder where you have extracted the Solo.msi file; 
3. Use the command msiexec /i Solo.msi /q KEY="license-key”. 
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General Features 

Navigating through the HPV Solo 2007 SP2 is easy and intuitive. There are certain features that you will 
find applicable in all views and which you can use to make your project content more readable. You can 
locate these features both in the Main Menu and in the Toolbar shortcuts. 
 
Views: 
Calendar 
Gantt Chart 
Network Diagram 
Task Usage 
Tracking Gantt 
Resource Graph 
Resource Sheet 
Resource Usage 
Task Sheet 

More Views: 
Bar Rollup 
Descriptive Network Diagram 
Detail Gantt 
Leveling Gantt 
Milestone Dates Rollup 
Milestone Rollup 
Multiple Baselines Gantt 
Custom Views 
Combination views and window split 
 

Tables: 
Predefined tables 
Create, modify or copy a table 
More tables 
Custom Tables 

Options: 
Date Format 
Currency options 
Outline options 
Time units options 
Calendar options 
 

Project: 
Sort 
Filter 
AutoFilter 
Task Information 
Task Notes 
Outline 
Expand all items 
Collapse all items 
Show outline level 
Project Information 
 

Print: 
Page Setup 
Print notes 
Print Legend 
Date range 
Scaling 
Header & Footer 
Print Preview 
Print 
Contextual Printing 

Edit: 
Select all 
Copy 
Find 
 

Reports: 
Standard Reports 
Export reports 

Insert: 
Insert Column 
Hide column 
Automatically adjust column's width 
 

Groups: 
Task Groups 
Resource Groups 

Format: 
Timescale 
Timescale Labels 
Layout 
Gridlines 

Other: 
Subprojects 
ODBC/OLE DB Connectivity 
Open MS Project Server 
Open Microsoft Project 2007 files 
Resource pool support 
Check password for password protected files 
Go to selected task 
Indicators 
Graphical indicators 
Bar rollup 
External tasks and links between projects 
 

 
 
 
 





 

File 

Open 
The Open functionality is available in two modes: Main Menu (File/Open) or Toolbar, the Open file icon. 
This functionality opens a pop-up window where you can specify the path to the new MPP file you want to 
view. 
 
An alternative solution to open and view a project file is to double-click on the MPP file in your Explorer or 
right click and select Open with HPV Solo in the contextual menu or drag and drop your MPP file in HPV 
Solo application.  
 
HPV Solo is also able to connect to a Microsoft Project Central Database, retrieve the list of projects and 
then open the selected ones. Find more about connecting to Microsoft Project Server >>. 
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Close 
Closes the current open document. 
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File 

Page Setup 
The Page Setup functionality is available in the Main Menu (File/Page Setup) and in Toolbar, the Page 
Setup icon. The page setup helps you define the printing settings: 
 
Page 
Margins 
Header and Footer 
Legend 
View 
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Page Setup - Legend 
Legend allows you to type or add specific project information in the text box. For instance, if you want to 
add the current date and time, click Insert Current Date / Insert Current Time. In order to add the file 
name, click Insert File Name. To add page numbers, click Insert Page Number / Insert Total Page Count 
and so on...  
 
Every page: the legend will appear on every printed page; 
Legend page: the legend will be printed on a separately page; 
None: the legend will not be printed. 
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File 

Page Setup - Header and Footer 
Header & Footer 
Header & Footer allows you to type or add specific project information in the text box. For instance, if 
you want to add the current date and time, click Insert Current Date / Insert Current Time. In order to 
add the file name, click Insert File Name. To add page numbers, click Insert Page Number / Insert Total 
Page Count and so on... 
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Page Setup - Margins 
Margins 
Helps you to specify the margins' width. 
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File 

Page Setup - Page 
Page Scaling 
Adjust to - the user can set the ratio aspect to which the printing should be performed;  
Fit to - formats the MPP file content to fit to the specified number of pages.  
Note: The paper size is calculated automatically. Adjust to and Fit to options are not available for 
Calendar, Task Usage and Resource Usage Views. 
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Page Setup -  View 
View 
Print all sheet columns: Click the check box to print all sheet columns in the view. 
Print first "n" columns on each page: Use this option to print predefined columns on each page.  
Print Notes: Click the check box in order to print the notes. The notes will be printed at the end of the 
document. Note: This feature is available for Gantt Chart, Tracking Gantt, Task Sheet and Resource Sheet 
views. 
Print blank pages: check or uncheck this option to print or not the blank pages. 
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File 

Print Preview 
The Print Preview functionality is available in two modes: Main Menu (File/Print Preview) or Toolbar, the 
Print Preview icon. When you click the Print Preview option a new window appears and the application 
generates the pages to be printed. The pages display the information in the exact format you set in the 
application: i.e. hidden columns, added columns, resized columns, resized panels etc. The pages follow 
the settings  selected at Page Setup (paper size, margins, orientation).  
 
The Print Preview window has a dedicated Menu: 
 
Page left/Page right: view the pages from left to right; 
Page up/Page down: view the pages from top to bottom; 
Zoom icon: you can magnify or diminish the page content; 
One page icon: displays a page to fit on the screen; 
Multiple pages icon: displays multiple pages to fit on the screen; 
Print button: sends the pages content to the printer; 
Page Setup button: you can customize the appearance of the printed pages; 
Close button: closes the Print Preview and returns to the main project viewer. 
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Print 
The Print functionality is available in two modes: Main Menu (File/Print) or Toolbar, the Print icon. By using 
this functionality the user can send the file content directly to the printer. Print opens a dialog form for 
printing the current view. 
 

 
 
Printer: Select the printer you want to use in order to print the mpp file content.  
Properties: opens a dialog window in which you can set printer options. This page is specific to each 
printer.  
Print to file: sends the printing content to a file instead to a printer. 
Print range: sets the number of pages to be printed. 
Copies: sets the number of copies to be printed. 
Timescale: All - displays the entire project timespan / Dates - displays information only for the specified 
data range. Note: This option is not available for Network Diagram and Resource Sheet views. 
 
See also Contextual Printing 
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File 

Contextual Printing 
When installing HPV Solo application, the setup program also adds to your Explorer Context Menu a Print 
option, through which you may Print directly an MPP File without opening HPV Solo application. The 
default view printed is Gantt Chart. This context menu appears only when you right click on a MPP file. 
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Properties 
Displays general information (type, location, size) and summary information (title, author, subject) about 
the currently opened project plan.  
 

 
 
 
 
 
 
 
 
 
 

24 



File 

Open MS Project Server 
HPV Solo is able to connect to a Microsoft Project Central Database, retrieve the list of projects and then 
open the selected ones. You must first configure the MSP Central settings through the Collaboration 
Options tab, then you may access the MSP Central database by selecting File/Open MS Project Server in 
the menu or by clicking the Open MS Project Server button in the toolbar.  
 
After selecting File/Open MS Project Server, HPV Solo will try to establish a communication with MS 
Project Server based on the logon information provided in Collaboration tab. If Windows User Account is 
selected to identify you with Project Server in Collaboration options, the login will be automatically made 
by the system, using your Windows account. If Microsoft Office Project Username is selected to identify 
you with Project Server in Collaboration Options, you will be asked to enter the password for the specified 
Project Server user name. To change the user name, click the General tab in this Options dialog box, and 
type a new name in the User name box. Once the connection is established, a list of projects available on 
Microsoft Project Central Server will be displayed. Select the project you want to view and click on Open. 
The project file will be opened with HPV Solo. 
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Open via ODBC 
HPV Solo provides the possibility to load MPP files through ODBC providers (including Microsoft SQL 
Server, Oracle, Microsoft Access, etc...). Notice that the database that needs to be imported must be in 
the format of the database from the Microsoft Project Central.  
 
To load a file in HPV Solo application through ODBC/OLE DB connectivity, click on File/Open via ODBC. In 
ODBC Data Source Administrator form select the tab System DSN, select the System Data Source and 
click on Ok button to open ODBC - Choose Project form. Within this form, select from the available list of 
projects and click on Open button. The project will be opened with Solo/PC application. 
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File 

Export to Excel 
Export to Excel option can be accessed via the menu File/Export to Excel, being available for Gantt Chart, 
Tracking Gantt and Task Sheet views. By using this option, the content of the list of tasks will be exported 
in a CSV format. This file format is supported by Excel Application and may be opened as a sheet. 
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Exit 
Closes the HPV Solo application. 



 

Edit 

Copy 
This option is located in the Main Menu (Edit/Copy) and you may use it in order to copy the selected cells 
to the clipboard.  
 
In the sheet portion of a view, select the information you want to copy (you can use the command Select 
all), and then click Copy. Open the document into which you want to insert the information you have 
copied and paste the information by using the destination program's Paste command.  
 
Note:  By using Export to Excel you can export information from Project in a Excel format. 
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Go To 
Go To option is located in the Main Menu (Edit/Go To) and you may use it in order to go to specified item.  
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Edit 

Hide column 
Hide Column option is available in the following views: Gantt Chart, Tracking Gantt, Resource Sheet, Task 
Usage and Resource Usage. This feature can be accessed by right clicking the header of the column you 
wish to hide and select Hide column from the context menu that appears . 
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Find 
Find option can be accessed either from the Main Menu (Edit/Find) or by clicking the Find icon. 
 
Enter the word you want to find in the task sheet (you may specify the field you want to be searched, 
apply different constraints to the search or specify search direction), then click Find Next button.  



 

View 

Calendar 
Description: The Calendar is the view that presents the tasks in a graphical manner on a day to day 
map. With blue bars for common tasks and black bars for milestones, tasks show their span over days or 
weeks. 
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Gantt Chart 
Description: The Gantt Chart view displays task information in two panels: The left panel displays 
information as a sheet and the right panel displays information as a chart. 
 
Panel 1 displays the task information as a sheet and includes details about start and finish task dates, 
resources assigned to them or % complete. Columns can be added or hidden by right-clicking on the 
panel's header. Also columns can be moved by dragging the header or resized dragging the column's 
margin. A double click on the right margin of a column sets the column's width to adjust the maximum 
length of the column content. Click on the "+"/"-" signs before a task name expands or collapses an 
aggregate task. 
 
Panel 2 displays the Gantt bar representation of the tasks. The bar's length and position on the timescale 
indicate when that task begins and ends. In addition, the position of one task bar in relation to another 
indicates whether the tasks follow one another or overlap. A double click on the chart's header displays a 
dialog to set the Timescale settings. 
 
Legend: The Gantt chart displays blue bars for common Tasks, black rhombuses for Milestones, blue bars 
connected with a continuous line for Task Splits, black bars for Summary Tasks. The background displays 
the Project’s calendar time span. 
 
Deadlines: A deadline indicates the target date when the user wants a task to be completed. The 
deadline is displayed in Gantt chart as a green arrow. 
 
Bar Roll-up: On the Gantt Chart, dates from subtasks can be rolled-up on a summary task bar in order to 
make important dates more visible. Bar roll-up displays symbols on a summary task bar that represent 
subtask dates ( for example, diamonds displayed on a summary task bar represent milestone subtasks).  
 
Bar Texts: A various project information (such as duration, constraint type, finish etc) can be used for 
the bar texts in order to describe a task. The position of the bar texts can be: left, right and inside.  
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View 

Network Diagram 
Description: The Network Diagram View displays the tasks and task dependencies as a flowchart. Tasks 
are shown in geometrical blocks along with their Start, Finish, Duration and Complete Percent information 
(where available). Task dependencies are displayed with connecting arrows between the Task blocks. Red 
border suggests a critical task. You can click the &rdquor;+” / ”-&rdquor; signs at top-right of the boxes 
to expand or collapse the summary tasks. 
 
Shapes legend: 
Parallelogram block: summary task 
Rhombus block: milestone 
Rectangle block: common task 
Block with no diagonal: unstarted task 
Block with one diagonal: task in progress 
Block with cross diagonals: finished task 
The arrows drawn between the task blocks show the precedence relations. 
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Task Usage 
Description: The Task Usage View is a matrix of work assignments. In a table spanned over the Project’s 
period, work loads are presented for each Task, and within it, each Resource, if any is available. 
 
Tip: Columns can be added or hidden by right-clicking on the panel's header. Also columns can be moved 
by dragging the header or resized dragging the column's margin.  
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View 

Tracking Gantt 
Description: The Tracking Chart view displays task information in two panels: The left panel displays 
information as a sheet and the right panel displays information as a chart. Tracking Gantt View integrates 
the Gantt Chart features. In addition, it also displays the critical path and the baseline information. In 
Tracking Gantt View, tasks are represented using 2 bars displayed one on top of the other. If no baseline 
is saved only one bar is shown. The lower bar shows baseline start and finish dates, and the upper bar 
shows scheduled start and finish dates. If baseline start and finish dates are the same with scheduled start 
and finish dates then the bars are identical in size and position. If they are different then the bars will 
appear slipped from one another, the initial and final positions being delayed with the difference from the 
Scheduled Start Date and Baseline Start Date, respectively with the difference from the Scheduled Finish 
Date and Baseline Finish Date. 
 
Panel 1 displays the task information as a sheet and includes details about start and finish task dates, 
resources assigned to them or % complete. Columns can be added or hidden by right-clicking on the 
panel's header. Also columns can be moved by dragging the header or resized dragging the column's 
margin. A double click on the right margin of a column sets the column's width to adjust the maximum 
length of the column content. Click on the "+"/"-" signs before a task name expands or collapses an 
aggregate task. 
 
Panel 2 displays the Gantt bar representation of the tasks. The bar's length and position on the timescale 
indicate when that task begins and ends. In addition, the position of one task bar in relation to another 
indicates whether the tasks follow one another or overlap. A double click on the chart's header displays a 
dialog to set the Timescale settings. 
 
Legend: The Tracking Gantt view displays blue bars for common Tasks, black rhombuses for Milestones, 
blue bars connected with suspension dots for Task Splits, black bars for Summary Tasks. A common task 
may be shown both in light and dark blue. The light blue color suggests the incomplete percentage of 
work; the dark blue color suggests the completed percentage. Red task bars identify the critical tasks. A 
critical task may be shown using both red-border, no fill color cells (showing the completed percentage) 
and red-fill cells (showing the uncompleted percentage). The background displays the Project’s calendar 
time span. Panel 2 also shows the last saved baseline. Baseline information is designed with gray bars in 
the Gantt Chart, below each referred task. 
 
Deadlines: A deadline indicates the target date when the user wants a task to be completed. The 
deadline is displayed as a green arrow. 
 
Bar Roll-up: On the Tracking Panel, dates from subtasks can be rolled-up on a summary task bar in 
order to make important dates more visible. Bar roll-up displays symbols on a summary task bar that 
represent subtask dates ( for example, circles displayed on a summary task bar represent milestone 
subtasks).  

37 



HPV_Solo_PC_2007_SP2_User_Guide_EN 

Resource Graph 
Description: The Resource Graph View displays the resource allocation information. Resources are 
displayed in a list. For each of them a 2D-barchart is shown (0x-time units, 0y-work load). The bars are 
colored part in blue for the work span within normal capacities of that resource and part in red for the 
over allocated work assignments. 
 
Tip: Use the Timescale to adjust your view by double clicking the chart's header. 
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View 

Resource Sheet 
Description: The Resource Sheet view displays resource information in a sheet format. You can review 
information about each resource: Name, Type, material label, Initials, Group, Max. Units, Standard Rate, 
Overtime Rate, Cost Per Use, Accrue At, Code. Columns can be add or hidden by right-clicking on the 
panel's header. Also columns can be moved by dragging the header or resized dragging the column's 
margin. A double click on the right margin of a column sets the column's width to adjust the maximum 
length of the column content. 
 
Tip: Overallocated resources are shown in red color.  
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Resource Usage 
Description: The Resource Usage View is a matrix of work assignments. In a table spanned over the 
Project’s period, work loads are presented for each Resource, and within it, each Task if any is available. 
This view is another side of the same aspect presented by Task usage. 
 
Note: Columns can be add or hidden by right-clicking on the panel's header. Also columns can be moved 
by dragging the header or resized dragging the column's margin. A double click on the right margin of a 
column sets the column's width to adjust the maximum length of the column content. 

40 



View 

More Views 
On the View menu, click the view you want to use. To use a view that is not on the View menu, click More 
Views, click the view you want to use in the Views list, and then click Apply. 
 

 
 
More Views: 
Bar Rollup 
Descriptive Network Diagram 
Detail Gantt 
Leveling Gantt 
Milestone Dates Rollup 
Milestone Rollup 
Multiple Baselines Gantt 
Task Sheet 
 
Custom Views: HPV Solo/PC 2007 provides the possibility to view the custom views as they were 
created/modified and saved in MS Project (including tables, inserted/hidden columns, text styles, bar 
format, zoom, filter, sort, etc..).  
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Table 
HPV Solo provides a set of tables used to show specific information about tasks, resources, and 
assignments in a sheet view.  
 
To apply a table to the view, point to Table on the View menu and then select the table you want to apply. 
There are two types of tables: task tables (which are applied to task type views) and resource tables 
(which are applied to resource type views): 
 

Resource tables: Task Tables: 
Cost Baseline 
Earned Value Constraint Dates 
Entry - Material Resources Cost 
Entry - Work Resources  Delay 
Entry  Earned Value 
Export  Earned Value Cost Indicators 
Hyperlink Earned Value Schedule Indicators 
Summary  Entry 
Usage  Export 
Work Hyperlink 

Rollup  
Schedule  
Summary  
Tracking 
Usage  
Variance  
Work 
 
You can use predefined tables to show only the fields you want, or you can create your own tables. To use 
a view that is not on the menu, click More Tables. 
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More Tables 
HPV Solo provides the possibility to create a new table or modify an existing table. If you want to create a 
new table, point to Table on the View menu and then select More Tables. To create a task/resource table, 
click Task/Resource and then click New. In order to modify a task/resource table, click Task/Resources 
(depending upon the view type), click the name of the table you want to modify in the Tables list, and 
then click Edit. To create a new table, based on an existing one, click Task/Resource, click the name of the 
table you want to base your new table on, and then click Copy.  
 
How to create/modify a table: 
Insert a name for the table in the Name box. 
Select a field name, data alignment, and column width.  
Select Yes in the Header Wrapping field to make the column field name wrap onto a second line. 
Select a date format for date fields in the Date format box, 
Type a number to change the row height in the Row height box.  
Select the Auto-adjust header row heights check box to automatically adjust row height so that all of 
the text is visible. 
 
How to copy a table: 
Insert a new name for the table in the Name box. 
In the list of fields, change the field name, data alignment, width, title, title alignment, and column 
header wrapping option for the table columns.  
Select  a date format in the Date format box.  
Type a new number in the Row height box to change the default row height for rows in your table. 
Select the Auto-adjust header row check box to automatically adjust row height so that all of the text 
is visible.  
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Reports 
General Information 

Reports are available from the Main Menu, View/Reports option and they are used to show various Project 
situations.  
 
EXPORT: Reports in a project can be exported as various types of files, such as Excel, Word, XML or 
image. To export a report, first select the report you want to export, then click on Export button. A 
window will be displayed, allowing you to select the export format and the path to the location where you 
want to save the report. Click on Ok to finish the export. 
 
Reports are split into 6 categories: 
 
Overview  
Current Activities 
Costs 
Assignments 
Workload 
Custom 
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Overview Reports 

This section displays information regarding the entire Project duration such as: Top Level tasks. 
 
Project Summary 
This report displays a summary of the project dates, durations, costs, work and task status. 
 
Top-Level Tasks 
This report displays a list with task information for tasks that are outlined at level 1 in the Project. 
 
Critical Tasks 
This report displays the list of critical tasks in project with their start and finish dates, successors, 
resources and so on. 
 
Milestones 
This report displays the list of milestones in project sorted by start date. 
 
Working Days 
This report displays the working days for the base calendar with their exceptions. 
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Current Activities Reports 

This section displays information regarding task information such as: Unstarted tasks, Tasks in Progress or 
Completed Tasks. 
 
Unstarted tasks 
This report displays a list with task information for tasks that are 0% complete (have no actual start 
date saved). 
 
Tasks Starting Soon (interactive report) 
This report displays the tasks starting within a specified timescale. 
 
Tasks in progress 
This report displays a list with task information for tasks that have the % complete value between 1 
and 99 (have an actual start date but no actual end date saved). 
 
Completed tasks 
This report displays a list with task information for tasks that are 100% complete (have both actual 
start and finish dates saved). 
 
Should have started tasks (interactive report) 
This report displays the tasks that should have started by a specified date. 
 
Slipping tasks 
This report displays the list of tasks that were rescheduled to finish after their baseline plan. 
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Cost Reports 

This section provides information regarding the costs of the project such as Overbudget Tasks or 
Overbudget Resources. 
 
Cash-Flow 
This report displays the costs per tasks on a weekly basis. 
 
Budget 
This report displays the budgeted cost of each task along with the variance between current and 
budgeted costs. 
 
Overbudget Tasks 
This report displays the tasks whose costs are greater then their baseline costs. 
 
Overbudget Resources 
This report displays the resources whose costs are greater then their baseline costs. 
 
Earned Value 
This report displays the project earned value. 
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Assignment Reports 

This section provides information regarding the project assignments such as Who Does What or To-Do 
List. 
 
Who Does What 
This report displays the resources with their assigned tasks, scheduled work, start and finish dates and 
details. 
 
Who Does What When 
This report displays the resources with their daily scheduled work. 
 
To-Do List (interactive report) 
This report displays the list of tasks with start and finish dates for a specified resource. 
 
Overallocated Resources 
This report displays the list of Overallocated resources and the tasks assigned to them. 
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Workload Reports 

This section provides information regarding the project workload such as Task Usage or Resource Usage. 
 
Task Usage 
This report displays the tasks with their assigned resources and scheduled work on a weekly basis. 
 
Resource Usage 
This report displays the resources with their allocated tasks and schedules work on a weekly basis. 
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Custom Reports 

If any of the reports you want to use was not found in the previous report categories, go to 
View/Reports/Custom Reports and select it from the list of available reports. This section provides addition 
information on your project, such as Crosstab Report.  
 
Resource Usage (material or work) 
This report displays the list of resources (material or work) with their assigned tasks and scheduled 
work on a weekly basis. 
 
Task 
This report displays task information. 
 
Crosstab 
This report displays the task and resource information in rows and the time increments in columns. 
 
 
EXPORT: Reports in a project can be exported as various types of files, such as Excel, Word, XML or 
image. To export a report, first select the report you want to export, then click on Export button. A 
window will be displayed, allowing you to select the export format and the path to the location where you 
want to save the report. Click on OK to finish the export. 
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Toolbars 
In the Toolbars section the user can choose to display or hide:  
 
Standard Toolbar 
Formatting Toolbar 
Caption Bar 
Status Bar 
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Formatting Toolbar 
Expand All - expands (opens) all items in the current view. This feature is supported only in Gantt 
Chart, Tracking Gantt, Task Sheet, Resource Usage and Task Usage views. 
 
Collapse All - collapses (closes) all expanded (open) items in the current view. This feature is 
supported only in Gantt Chart, Tracking Gantt, Task Sheet, Resource Usage and Task Usage views. 
 
Show drop down button - Allows the user to select the Outline Level of detail. 
 
Filter combobox - Opens the Filter dialog box and will help filter the tasks and resources on different 
criteria. 
 
Filter icon - opens More Filters form, allowing the user to select from the list of available filters. 
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Standard Toolbar 
Open - opens a dialog window where the user can locate the mpp file. Click Open to view the file. 
Click on the small arrow beside the Open icon in order to view one of the 5 latest opened files. 
 
ODBC - opens ODBC Data Source Administrator. 
 
MSPC Link - opens the list of available projects on Microsoft Project Central. 
 
Close - closes the currently opened project file. 
 
Page Setup - opens a dialog where you can set the page properties. 
 
Print - prints the current open view. 
 
Print Preview - opens the Print Preview window where the user can view the formatted content. 
 
Copy - copies the selected information. 
 
Task information - displays the task information for the selected task. 
 
Task Notes - displays the task notes for the selected task. 
 
Groups combo-box - allows the user to select one of the groups from the list of available groups. 
 
Zoom In - increases the resolution in the current view. This feature is supported only in Gantt Chart, 
Tracking Gantt, Calendar, Network Diagram and Resource Graph views. 
 
Zoom Out - decreases the resolution in the current view. This feature is supported only in Gantt 
Chart, Tracking Gantt, Calendar, Network Diagram and Resource Graph views. 
 
Find - Searches a task in the current view. This feature is supported only in Gantt Chart, Tracking 
Gantt and Task Sheet. 
 
Sort - Opens the sort dialog box and ill help sort the tasks and resources on three criteria.  
 
Go to selected task - scrolls the gantt panel and displays the selected task(s). 
 
Reports - opens Reports form, allowing the user to select from the existing categories of reports. 
 
About - Displays informations regarding the current version of HPV Solo/PC. 
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Caption Bar 
Displays the title of the active view. 
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Status Bar 
Displays the status of the document. 
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View Bar 
Shows/hides View Bar. 
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Page Setup - Header and Footer 
Header & Footer 
Header & Footer allows you to type or add specific project information in the text box. For instance, if 
you want to add the current date and time, click Insert Current Date / Insert Current Time. In order to 
add the file name, click Insert File Name. To add page numbers, click Insert Page Number / Insert Total 
Page Count and so on... 
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Zoom 
The Zoom functionality is available in two modes: Main Menu (View/Zoom) or Toolbar, by clicking on the 
magnifying glass with (-) (Zoom in) or (+) (Zoom out) buttons. The Zoom engine currently implements 
seven levels of details: 
 
1. One week level (the visible unit is one week). 
2. 2 weeks level 
3. One month level (the visible unit is one month). 
4. 3 months level 
5. Selected tasks 
6. Entire project 
7. Custom level: the user can select multiples of Days/Weeks/Months/Years to see in the chart panel or 

in the print preview format. 
 
Every time the view is selected it displays the chart information according to the zoom saved in MS Project 
for the respective view. 
 
Note: The Zoom functionality is available in Gantt Chart, Tracking Gantt, Resource Graph, Network 
Diagram, Task Usage, Resource Usage and other related views. 



 

Insert 

Column 
Insert Column option is available in the following views: Gantt Chart, Tracking Gantt, Resource Sheet, 
Task Usage and Resource Usage. Use this functionality in order to add a column to the sheet list of the 
current view. 
 
Field name - displays a list of available fields that can be viewed in the sheet panel. 
 
Title - is used to rename the selected field. 
 
Align - aligns (right/center/left) the column name and the column content. 
 
Width - specifies what width the selected column would have in the sheet panel. 
 
Every time the view is selected it displays the sheet information according to the last saved columns in 
Microsoft Project. 
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Format 

Timescale 
Format Timescale option is available in the following views: Gantt Chart, Tracking Gantt, Resource Graph, 
Task Usage, Resource Usage and other related views. The Timescale helps the user to customize the 
layout of the chart panel. 
 
Tier formatting:  
Top - refers to the first row delimiting dates in the chart panel. It can be used to change the display to 
Units like Days / Weeks / Months / Years and to specify the alignment of the text. Use tick lines if you 
want to separate the selected time units.  
Middle - refers to the second row delimiting dates in the chart panel. It can be used to change the display 
to Units like Days / Weeks / Months / Years and to specify the alignment of the text. Use tick lines if you 
want to separate the selected time units.  
Bottom- refers to the third row delimiting dates in the chart panel. It can be used to change the display to 
Units like Days / Weeks / Months / Years and to specify the alignment of the text. Use tick lines if you 
want to separate the selected time units. 
Note: The time unit used in the Top row must be larger than the time unit used in the Bottom row. 
 
Labels:  
Within this field, the user can choose the date label to appear for any of the tiers in the timescale. 
 
Common:  
Size - specifies the width (%) of the column displayed in background and which delimits the time units.  
Scale separator: marks the limit between Top and Bottom row. 
 
Non-working time:  
Behind task bars - the non-working time columns displayed in background are delimited by borders.  
In front of task bars - the non-working time columns displayed in background are not delimited by 
borders.  
Do not show - the non-working time columns are displayed in white color.  
Color: choose the color you want to see the non-working time columns. 
 
Preview:  
The Preview section shows the changes that were selected in the above described sections of the 
Timescale. 
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Gridlines 
Format / Gridlines option is used for enhancing the visibility of a view, by changing the pattern and colors 
of gridlines (vertical or horizontal lines that divides columns or rows in a view). 
 
Gridlines can be formatted by performing the following steps: 
 
1. Click on Gridlines in the Format menu 
2. Select the type of gridlines you want to change in the Line to change list 
3. Select the line pattern you want to use in the Type box, under Normal 
4. Select the line color you want to use in the Color box, under Normal 
5. For setting contrasting gridlines at specified intervals, select a line type, pattern, color and interval 

under At interval 
 
Note: If you don’t want a gridline to appear in a view, select the blank area in the Type box. 
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Layout 
Layout option can be accessed either from Format menu or by right clicking in Gantt panel and selecting 
Layout from the contextual menu. This option will help the user to change the appearance of links, to set 
the bar height and bar date format and to display or hide drawings, rollup or split tasks. 
 
Links: The link lines show the task dependencies of the linked tasks. You can change the appearance 
of links or hide them by selecting one of the three display formats available for links. 
 
Date format: For changing the date format for bars in Gantt panel, click on Date Format combo-box 
and select in the list the date format you want to use. 
 
Bar height: This option helps the user to adjust the height of Gantt bars to make them easier to 
review. Click on Bar height comb-box and select the size you want to use. 
 
Always roll-up Gantt bars: On the Gantt Chart, dates from subtasks can be rolled-up on a summary 
task bar in order to make important dates more visible. If this option is checked, the Gantt bars will be 
rolled up on their summary tasks. 
 
Hide rollup when summary expanded: By checking this option, the rollup will be hidden if the 
summary task is expanded. Once the summary is collapsed, the rollup will be displayed again. 
 
Round bar to whole days: If this option is checked, the bars will be rounded to whole days. Uncheck 
this option if you want to see the exact timespan of bars. Notice that this option takes effect only on 
the default zoom (week/day). 
 
Show bar splits: Check/uncheck this option to display/hide the bar splits in the view. 
 
Show drawings: When checking this option, the drawings (if any) will be displayed in the view. 
Notice that you cannot insert new drawings, but you can choose to display/hide existing drawings. 
 
 
Note: Layout option is available only for Gantt-type views. 
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Graphical Indicators 
HPV Solo displays graphical indicators used in Microsoft Project to quickly see when the data in a custom 
field meets specific criteria. The graphical indicators may be used in a custom field instead of the actual 
data.  
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Indicators 
The Indicators field is located to the right of the ID field and give different types of information about a 
task or resource. HPV Solo supports the following indicators: 
 

The task, resource, or assignment has a note attached to it.  
 
The task, resource, or assignment has a hyperlink associated with it.  
 
The task finishes on a date that is later than its deadline. If the deadline date passes and the 
task is not completed, an indicator date will be displayed. 

 

The task has an inflexible constraint . The inflexible constraints are Must Finish On, Must Start 
On. 

 

 
The task has a moderately flexible constraint. Flexible constraints are As Soon As Possible, As 
Late As Possible, Finish No Earlier Than, Finish No Later Than, Start No Earlier Than, and Start 
No Later Than.  

 

The task has not been scheduled or completed within the constraint's time frame.  
 
The task has a calendar applied to it.  
 
The task is complete.  
 
The task is an inserted project (also called a subproject). The inserted project appears as a 
summary task in the master project.) 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Tools 

Links Between Projects 
This option is located in the Main Menu (Tools/Links Between Projects). 
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Tracking 
Progress Lines 

Progress Lines represent the progress of your project, displayed visually in the Gantt Chart view. 
Progress lines connect tasks, creating a graph on the Gantt Chart indicating work that is behind or ahead 
the plan. 
 
On the Tools menu, Tracking submenu, click Progress Lines. In Progress Lines form use the Dates 
and Intervals tab to set preferences for the way you want to display dates and intervals with progress 
lines. 
 
On the Date and Intervals tab you can set preferences for where to display the progress lines: 
- Display progress lines at regular intervals  
- Display progress lines based on a specific status date 
- Display progress lines for specific dates you select 
- Display progress lines compared with the baseline plan or with the actual plan 
 
On the Line Styles tab you can set preferences for how to display the progress lines: 
- Change the shape, color, and pattern of the line 
- Set shapes to identify where the line connects to task bars 
- Display the progress date at the top of each line 
- Differentiate current from past progress lines by changing how they are displayed 
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Options 
On the Tools menu, click Options, and then change the setting you want: 
 
View 
General 
Calendar 
Collaborate 
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Options - Calendar 
Calendar: (read-only) displays the calendar options for the project, as they were defined in Microsoft 
Project. 
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Options - General 
General: 
Open last file on startup 
Recently used files list entry: to change the number of files listed on the menu, type or select the number 
of entries. 
View options for time units. 
Username: change the Project Server user name to authenticate with Project Server. 
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Options -  View 
View: 
Date Format: change the date format in all the views of the application by choosing from a list of available 
formats. 
Show Status Bar: select or clear the check box.  
Currency options: Symbol, Placement, Decimal Digits 
Outline Options: Indent Name: select or clear the check box; Show outline number: select or clear the 
check box; Show outline symbol: select or clear the check box; Show summary tasks: select or clear the 
check box; Show project Summary tasks: select or clear the check box. 
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Organizer 
On the Tools menu, click Organizer. In Organizer form click the tab for the project element you want to 
copy, rename, or delete.  
 
The Organizer is used to move project elements such as views, tables and filters between the local file 
and the global template. You can also use the Organizer to rename or delete elements in the global 
template and the local file.  
Changes in project elements are saveable only in the Global Template. In case you copy, rename or delete 
project elements from Global Template to local file, those project elements will not be saved in the local 
file. 
 
There are 5 tabs available in the Organizer dialog box. 
 
Use the Organizer dialog box to copy, rename, or delete any of the following elements: 
• Views  
• Tables 
• Filters 
• Calendars 
• Groups 





 

Project 

Sort 
Sort option can be accessed in two modes: Main Menu (Project/Sort) and Toolbar, the Sort icon. This 
option allows the user to sort tasks and resources by specified criteria. All predefined sort criteria are 
available in HPV Solo.  
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Filtered for... 
Filter option can be accessed in two modes: Main Menu (Project/Filter) and Toolbar, the Filter icon. The 
filter option allows the user to view a particular type of information in the project by displaying only the 
information the user is interested in and hiding the rest. If there are no filters to apply, then all the items 
will be taken into consideration. 
 
Task Filters: allow the user to view specific aspects of tasks. This option is available for Gantt Chart, 
Network Diagram, Task Usage and Tracking Gantt views. 
 
All tasks 

All tasks will be displayed, regardless of their particularities. 
 

Completed Tasks 

This filter shows all tasks that are finished. 
 

Cost Greater Then (interactive filter) 

This filter shows tasks whose cost is greater then a specified amount. 
 

Cost Overbudget 

This filter shows all tasks with a cost greater than the baseline cost. 
 

Created After (interactive filter) 

This filter shows all tasks created after a specified date. 
 

Critical 

This filter shows all tasks that are on a critical path. 
 

Date Range (interactive filter) 

This filter shows all tasks that start or finish after the earlier specified date and before the later specified 
date. 
 

Incomplete Tasks 

This filters shows all tasks that are not completed. 
 

In progress tasks 

This filter shows all tasks that are started but not completed yet. 
 

Late/Overbudget tasks assigned to (interactive filter) 

This filter shows all tasks assigned to a specified resource that are exceeding the budget or finishing after 
the finish date in the baseline plan. 
 

Linked fields 

This filter shows the tasks to which information from other programs has been linked. 
 

Milestones 

This filter shows only the tasks that are milestones. 
 

Resource Group (interactive filter) 

This filter shows the tasks allocated to the resources belonging to a specified group. 
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Should start by (interactive filter) 

This filter shows all tasks that should have started by a selected date but they haven't. 
 

Should start/finish by (interactive filter) 

This filter shows all tasks that haven’t started or finished within a specified date range. 
 

Slipped/Late Progress 

This filter displays tasks that have slipped behind their schedule finish date or haven’t been progressing as 
scheduled. 
 

Slipping Tasks 

This filter shows all tasks that are behind schedule. 
 

Summary 

This filter shows all tasks that have subtasks.  
 

Task Range (interactive filter) 

This filter shows all tasks that have ID numbers within the specified range. 
 

Tasks with a Task Calendar assigned 

This filter shows all tasks to which a task calendar was applied. 
 

Tasks with Attachments 

This filter shows all tasks to which a note or object was attached. 
 

Tasks with Deadlines 

This filter shows all tasks to which a deadline was specified. 
 

Tasks with Estimated Durations 

This filter shows all tasks whose duration is estimated. 
 

Tasks with Fixed Dates 

This filter shows all tasks that have an actual start date. 
 

Tasks/Assignments with Overtime 

This filter shows all tasks or assignments that are specified as overtime work. 
 

Top Level Tasks 

This filter shows the highest-level summary tasks. 
 

Unstarted Tasks 

This filter shows tasks that haven't started. 
 

Using Resource in Date Range (interactive filter) 

This filter shows the tasks allocated to a specified resource within a specified date range. 
 

Using Resource (interactive filter) 

This filter shows all tasks that use the specified resource. 
 

77 



HPV_Solo_PC_2007_SP2_User_Guide_EN 

Work Overbudget 

This filter shows all tasks whose scheduled work is greater then the baseline work. 
 

 
Resource Filters: allow the user to view specific aspects of resources. This option is available for 
Resource Graph, Resource Sheet and Resource Usage views. 
 
All Resources 

All resources will be displayed, regardless of their particularities. 
 

Cost Greater then (interactive filter) 

This filter shows all resources whose cost is greater then a specified amount. 
 

Cost Overbudget 

This filter shows all resources whose scheduled cost is greater then the baseline cost. 
 

Date Range (interactive filter) 

This filter shows all tasks and resources with assignments that start or finish within the specified date 
range. 
 

Group (interactive filter) 

This filter shows all resources belonging to a specified group. 
 

In Progress Assignments 

This filter shows the assignments that have been started but not yet completed. 
 

Linked fields 

This filter shows the resources to which information from other programs has been linked. 
 

Overallocated Resources 

This filter shows all resources that are overallocated. 
 

Overbudget Resources 

This filter shows all resources with a scheduled cost greater than the baseline cost. 
 

Resource Range (interactive filter) 

This filter shows all resources that have ID numbers within the specified range. 
 

Resource - Material 

This filter shows the material resources. 
 

Resource - Work 

This filter shows work resources. 
 

Resources with Attachments 

This filter shows the resources to which a note or object has been attached. 
 

Resources/Assignments with Overtime 

This filter shows the resources or assignments that are specified as working overtime. 
 

Should start by (interactive filter) 
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This filter shows all tasks or assignments that should have started by a specified date but haven't. 
 

Should start/finish by (interactive filter) 

This filter shows all tasks that haven’t started or finished within a specified date range. 
 

Slipped/Late Progress 

This filter displays tasks or assignments that have slipped behind their schedule finish date or haven’t 
been progressing as scheduled. 
 

Slipping Assignments 

This filter shows all assignments that have slipped from their original baseline plan. 
 

Unstarted Assignments 

This filter shows all assignments that haven’t yet started. 
 

Work Complete 

This filter shows resources that have completed all of their assigned tasks. 
 

Work Incomplete 

This filter shows all resources with scheduled work less than the baseline work. 
 

Work Overbudget 

This filter shows all resources whose scheduled work is greater than the baseline work. 
 

 
Custom Filters: HPV Solo application provides all standard filters but also custom filters as they were 
defined and saved in MS Project for a particular file. If any of the standard or custom filters you want to 
use is not in the Project/Filtered for list, go to Project/Filtered for/More Filters and select it from the list of 
available filters. 
 
Highlight Filters: You can view the filtered information as highlight text by setting the filter as highlight 
filter. In order to highlight a filter, go to Project/Filtered for/More Filters, select a filter in the list of 
available filters and then click on Highlight button. The tasks or resources that meet the filter’s criteria will 
be displayed as highlight (blue) text in the view. 
 
AutoFilter 
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AutoFilter 
AutoFilter can be activated/deactivated from Project menu / Filtered for... / Autofilter or from toolbar. 
Each column can be filter by pressing arrow button, and selecting an option / define a custom autofilter. 
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Project 

Group by... 
Groups option can be accessed from Project menu or by selecting them in the Groups combo-box in 
toolbar. Groups are used to view specific categories of information in the project related to tasks or 
resources.  
 
Task Groups: 
Complete and Incomplete Tasks 

displays the tasks in the project in three Work Complete Groups: 0%, 0%-99%, 100%. 
 

Constraint Type 

displays the tasks in the project according to one of the following constraints: As Late As Possible, As 
Soon As Possible, Finish No Earlier Than, Finish No Later Than, Must Finish On, Must Start On, Start No 
Earlier Than, and Start No Later Than. 
 

Critical 

displays the tasks in the project according to whether the task is critical or not. 
 

Duration 

displays the tasks in the project according to the duration they take to complete. 
 

Duration then Priority 

displays the tasks in the project first according to the duration they take to complete and second by 
priority within each duration group. 
 

Milestones 

displays the tasks according to whether the task is milestone or not. 
 

Priority 

displays the tasks according to their priority. 
 

Priority Keeping Outline Structure 

displays the tasks according first to their outline number and second to their priority. 
 

 
Resource Groups:  
Complete and Incomplete Resources 

displays the resources in the project in three Work Complete Groups: 0%, 0%-99%, 100%. 
 

Resource Group 

displays the resources in the project according to the group they belong to. 
 

Standard Rate 

displays the resources in the project according to their standard rate. 
 

Work vs. Material Resources 

displays the resources in the project according to whether a resource is a material resource or a work 
resource. 
 

Assignments keeping Outline Structure 
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displays the resources grouped first by their outline structure and, then, by assignments. 
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Project 

Outline 
This option is located in the toolbar and displays the tasks for the specified level. To show only part of the 
outline (A hierarchical structure for a project that shows the tasks groupings), click Show, and then click 
the outline level number up to which you want to view.  
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Task Information 
Task Information form may be accessed from the Main Menu (Project/Task Information) or by double-
clicking on a task. This feature is available for Gantt Chart, Tracking Gantt, Task Usage and Resource 
Usage views. 
 
Task Information contains various data regarding a task: 
General - Name, Duration, Percent Complete, Priority, Start, Finish. 
Advanced - Name, Duration, Deadline, Constraint Type, Constraint Date, Task Type and WBS code. 
Notes - displays the notes related to a task, if any. 
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Project 

Task Notes 
Task Notes option is available in the following views: Gantt Chart, Tracking Gantt, Task Usage and 
Resource Usage. If a task is selected this option displays the Notes attached to it. 
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Project Information 
The Project Information window is available from the Main Menu, Project / Project Information. 
The Project Information window presents general information about the Project such as: Start and Finish 
dates of the Project, Current Date, Status date shows the date against which earned value calculations are 
performed, Calendar specifies the Project’s Calendar type and Priority indicates how readily are the 
resources from this project when competing on multiple projects.  
 
Note: Project’s Priority overrides Task’s Priority. 
 

 



 

Collaborate 

Options - Collaborate 
Collaborate:  
Collaborate using: - Specifies whether you are using Project Central Server or not. 
Project Server URL and Test Connection button - Use this section to specify the URL for Project Central 
and check whether the connection to Project Server is working properly. 
Identification for Project Server: Use this section to set up the authentication method with Microsoft 
Project Central Server.  
Windows User Account - Uses current user’s credentials to authenticate with Microsoft Project Central. 
Once the user selects this type of authentication, username and password fields will be disabled as the 
application uses the current logon credentials. 
Microsoft Office Project Username - Uses the Project Server User name specified in the General tab. To 
change the user name, click the General tab in this Options dialog box, and type a new name in the User 
name box.  
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Window 

Window Split 
This option is located in the Main Menu (Window/Split). 
 
Two windows will be displayed. Top or bottom views can be changed using view bar / View menu. 
 
Note: On bottom view will be displayed only related items for selected items on top view. 





 

Help 

HPV Help 
Opens this Help. 
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Register 
The Register option is available from the Main Menu, (Help /Register) and allows the user to change the 
Application status from Trial to Complete Version if the registration number is correct. 
 
If you need more information about the registration process send an email to 
sales@projectviewercentral.com or call 1.413.822.5675. 
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Help 
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About HPV 
The About HPV option is available from the Main Menu and provides the current version series and 
additional copyright information. 
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